Working With Microsoft Word

Formatting Your Document
Formatting Your Text
Reviewing Your Document
Saving

Working With Images
Working With Tables
Creating a Table of Contents

Want more information?
974 8000 ext 6045
twist@eit.ac.nz
# Table of Contents

**Chapter 1: Formatting your Document**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserting Headers and Footers</td>
<td>2</td>
</tr>
<tr>
<td>Inserting Page Numbers (and formatting them)</td>
<td>3-5</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>6</td>
</tr>
<tr>
<td>Margins and Page Orientation</td>
<td>7-8</td>
</tr>
<tr>
<td>Page Breaks and Section Breaks</td>
<td>9</td>
</tr>
</tbody>
</table>

**Chapter 2: Formatting your Text**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aligning Text</td>
<td>10</td>
</tr>
<tr>
<td>Bullets and Numbering</td>
<td>11-13</td>
</tr>
<tr>
<td>Format Painter</td>
<td>14</td>
</tr>
<tr>
<td>Hanging Indent</td>
<td>15</td>
</tr>
<tr>
<td>Superscript - to the power of - exponential notation</td>
<td>16</td>
</tr>
</tbody>
</table>

**Chapter 3: Review your Document**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Count</td>
<td>17</td>
</tr>
<tr>
<td>Spell Check</td>
<td>18-19</td>
</tr>
<tr>
<td>Thesaurus</td>
<td>20-21</td>
</tr>
</tbody>
</table>

**Chapter 4: Working with Images**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserting images: From your computer</td>
<td>22</td>
</tr>
<tr>
<td>Inserting images: From the internet</td>
<td>23-24</td>
</tr>
<tr>
<td>Inserting images: From Clip Art</td>
<td>25</td>
</tr>
<tr>
<td>Capturing Screen Snapshots</td>
<td>26</td>
</tr>
<tr>
<td>Formatting your images</td>
<td>27</td>
</tr>
</tbody>
</table>

**Chapter 5: Working with Tables**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is a table?</td>
<td>28</td>
</tr>
<tr>
<td>Inserting a table</td>
<td>29-30</td>
</tr>
<tr>
<td>Entering data in a table</td>
<td>31-32</td>
</tr>
<tr>
<td>Sorting information in a table</td>
<td>33-34</td>
</tr>
<tr>
<td>Inserting Rows and Columns in a table</td>
<td>35-36</td>
</tr>
<tr>
<td>Deleting Rows and Columns in a table</td>
<td>37</td>
</tr>
<tr>
<td>Formatting your table with styles</td>
<td>38</td>
</tr>
</tbody>
</table>

**Chapter 6: Table of Contents**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Table of Contents</td>
<td>39-40</td>
</tr>
<tr>
<td>Updating a Table of Contents</td>
<td>41</td>
</tr>
</tbody>
</table>

**Chapter 7: Saving**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving your Document</td>
<td>42-44</td>
</tr>
<tr>
<td>Saving to a USB Memory Stick</td>
<td>45-46</td>
</tr>
</tbody>
</table>
Inserting Headers and Footers

1. Insert << Header

2. Enter header text

3. Insert << Footer - enter footer text

Viewing / Editing Header and Footer
Double click on the Header or Footer area to view or edit text. Press Esc (on your keyboard) to return to your document.
Formatting your Document

Inserting Page Numbers (and formatting them)

Inserting Page Numbers and formatting them

1. Insert << Page Number

2. Identify where you want your Page Numbers to be positioned (top or bottom of page), then select the formatting

3. To edit the numbers double click the Header or Footer area and highlight the number you want to edit
4. To format the page numbers go to Insert << Page Number << Format Page Numbers

5. Select the formatting, click OK to return to your document.

Inserting Page Numbers: Different on the First Page

1. This situation will be useful when you do not want a page number on the first page
   Page Layout << Page Setup << click the arrow in the bottom right hand corner

2. Layout << check the Different First Page box in Headers and Footers << Apply to Whole Document
   (when you have no sections in your document, in which case select This section).
Inserting Page Numbers Different than 1

1. Insert << Page Number << Format Page Numbers

2. Type the Page Number you want to start at. You may want to use 0 if you set your document with a Different on the first page system. This way your first page will be 0 (and not show) and the second page will begin at page 1.

Inserting Page Numbers: Different Page Numbers in One Document

You may want to set out an essay with two different number styles. In academic essays Roman numerals start after the title page until the body of the essay begins. For example this may include an abstract, table of contents, executive summary etc… Arabic numbers start from the main body of the essay. To achieve this you will need to use section breaks in your document. Change the number format in the Page Number Format window.

It is easier to tackle the Page Layout first and create the section breaks in your document before you add the text.

Turn the show/hide button on, this shows paragraph marks and other hidden (will not show on your printed document) formatting symbols, this will show your section breaks clearly.
Formatting your Document

Line Spacing

Line spacing determines the amount of space between each line space; you can set the line spacing before you start to type OR you can highlight selected text and change the line spacing.

1. Home << Line Spacing Icon

<table>
<thead>
<tr>
<th>This is single line spacing</th>
<th>This is double (2.0) line spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is single line spacing</td>
<td>This is double (2.0) line spacing</td>
</tr>
<tr>
<td>This is single line spacing</td>
<td>This is double (2.0) line spacing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This is 1.15 line spacing</th>
<th>This is 2.5 line spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is 1.15 line spacing</td>
<td>This is 2.5 line spacing</td>
</tr>
<tr>
<td>This is 1.15 line spacing</td>
<td>This is 2.5 line spacing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This is 1.5 line spacing</th>
<th>This is 3.0 line spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is 1.5 line spacing</td>
<td>This is 3.0 line spacing</td>
</tr>
<tr>
<td>This is 1.5 line spacing</td>
<td>This is 3.0 line spacing</td>
</tr>
</tbody>
</table>
Margins and Page Orientation

By default, the margins for a Word document are 2.54 cm on the top, bottom, and sides.

1. Page Layout << Margins - select Normal or Custom Margins.

NB: This is useful for changing margins in your assignment.

Custom Margins

1. If you select Custom Margins the Page Setup window appears. Tab (or use the arrow keys) between each option and type in your margins. Click OK to apply the changes.

Most EIT assignment presentations requirements have a left margin of 4cm, to do this simply enter 4 in Left Margin << click OK.
Page Orientation

1. Page Layout << select Orientation

2. Choose Portrait or Landscape

NB: To have pages of portrait and landscape orientation in a single document, use section breaks between the affected pages. To do this:

1. Go to the page you want to change the orientation of, select the area before the text on the page you want to change. Page Layout << Breaks << Next Page

2. Select the area after the text on the same page, Page Layout << Breaks << Next Page

3. The document is now comprised of three sections. Select an area in the page you want to change the orientation of. Page Layout << Orientation << Portrait OR Landscape
Page Breaks and Section Breaks

Page Break: Separates content between pages
Section Break: Used to create layout or formatting changes in a portion of a document.

Inserting a Page Break

1. Click in your document where you want to start a new page, Insert << Page Break

Inserting a Section Break

1. Click where you want to change the format, Page Layout << Breaks

2. Choose the type of Break you want for your document.
Aligning Text

1. The text alignment in Microsoft Word documents is pre-set to left alignment.
2. To change the alignment select the text (sentence, paragraph, section) you want to change.
   NB: To select the entire document use the Shortcut Key <CTRL+A>
3. The alignment icons are on the menu bar of the Home tab

4. There are four different types of alignment;
   Left

   Centre

   Right

   Justify

Want more information?
974 8000 ext 6045
twist@eit.ac.nz
Bullets and Numbering

Bullets and numbering are used to emphasize lists of things and usually make lists easier to read and follow.

How to apply bullets while you type:
Click on the Bullets icon << Type your text << Enter
OR
Select text you want on a bullet list << click on the Bullets icon

Example: Bullet List
Agenda
• Karakia
• Mihi
• Review Policies
• Chairperson Report

Bullets and Numbering
Select text << Click on triangle to right of Bullet icon << Select from Bullet Library or Define New Bullet

Example: Bullet List
Agenda
• Karakia
• Mihi
• Review Policies
• Chairperson Report
Numbering:
How to apply numbering while you type:
Click on Numbering icon << Type your text << Enter
OR
Select text you want on a numbered list << click on the Numbering icon

Example Numbered List
1. Click on button
2. Picture here
3. Choose numbering
4. Picture here

Numbering: Change Formatting
Select text << Click on triangle to right of the Numbering icon << Select from Numbering Library or Define New Number Format.

Example Numbered List
I. Click on button
II. Picture here
III. Choose numbering
IV. Picture here
Outline Numbering:
This is mainly used in a large scale report where you require Headings and sub headings to be numbered. Highlight text << click on Outline Numbering << select list type (click on triangle to right of Outline Numbering icon) << enter and your document will be numbered from one to fifteen as in the example below; increasing the indent by one or two will change the list level as displayed in the following examples.

Example Outline Numbering: No Indent
1. Executive Summary
2. Method of investigation
3. Evidence
4. Conclusions
5. Introduction
6. The major issues to be addressed
7. The intended readers
8. The name of the person who commissioned it
9. The boundaries of the investigation
10. An indication of how widely the research was conducted (scope)
11. An acknowledgment of people who provided specific assistance
12. Terms of Reference
13. Body
14. Conclusion
15. Recommendations

Example Outline Numbering: Increase Indent Once
1. Executive Summary
  1.1. Method of investigation
  1.2. Evidence
  1.3. Conclusions
2. Introduction
  2.1. The major issues to be addressed
  2.2. The intended readers
  2.3. The name of the person who commissioned it
  2.4. The boundaries of the investigation
  2.5. An indication of how widely the research was conducted (scope)
  2.6. An acknowledgment of people who provided specific assistance
3. Terms of Reference
4. Body
5. Conclusion
6. Recommendations

Example Outline Numbering: Increase Indent Twice
1. Executive Summary
  1.1. Method of investigation
  1.2. Evidence
  1.3. Conclusions
2. Introduction
  2.1. The major issues to be addressed
  2.2. The intended readers
  2.3. The name of the person who commissioned it
  2.3.1. The boundaries of the investigation
  2.3.2. An indication of how widely the research was conducted (scope)
  2.3.3. An acknowledgment of people who provided specific assistance
3. Terms of Reference
4. Body
5. Conclusion
6. Recommendations
Formatting your Text:

Format Painter:

This is used to copy formatting from one part of your document, and apply it to another part of your document.

1. Highlight the formatting you want to use in another part of your document.
2. Click on the Format Painter icon.
3. Highlight the text you want to change, and it will change to the copied format.

NB: Double click on Format Painter – it will stay highlighted. This allows you to apply the same formatting to multiple places in your document.
Hanging Indent:
1. Select the text.
2. Home << Paragraph

3. Select Hanging from the Special drop-down list in the Indents and Spacing tab << OK

Example:

NB: This is useful when adding references for your assignments, however if you have a large list you may choose to use the EndNote software provided for you by EIT (available from the Library)
Superscript - “...to the power of...” or exponential notation:

You may need to create superscript characters within your assignments and formulas. Superscript sits just above the center line.

1. Highlight the number/s
   (Hold down the Ctrl key and double click on the numbers if you want to change multiple numbers)

2. Home << Superscript
Review your Document

Word Count

Counting the number of words in your document

Microsoft Word has a function that can count the number of words in your document while you type; it can also count the following:

- Pages and Lines
- Characters, including or excluding the spaces

Count the words as you type

When you type in a document, Word automatically counts the number of pages and words in your document and displays them on the status bar at the bottom of your Word document.

Sometimes this doesn't appear, if so right-click on the status bar >> select Word Count

Count the words in a sentence or paragraph

You can count the number of words in selected text rather than all of the words in your document.

1. Simply select the text with your mouse that you want to count.
2. The status bar shows you the number of words in the selection.

33/965 means that the selected text accounts for 33 words out of a total number of words in your document, 965.

NB: If you have multiple paragraphs within your document you want to count, hold the CTRL key down on the keyboard and select these paragraphs using your mouse. It will show your word count just for these paragraphs.

Want more information?
974 8000 ext 6045
twist@eit.ac.nz
Review your Document

Spell Check

Click on the Review tab, in the Proofing group, click Spelling & Grammar.

Spelling & Grammar will go through the whole of your document and check each word for you.

If a spelling mistake is found the following dialogue box will appear;

As you can see there are multiple options to deal with the suggestions that Word has given you, normally the correct spelling is the first suggestion shown and you can click on the change button to correct your misspelling.
Automatic Spell Check from Home

This is where Word automatically checks your spelling as you type; there are some options you need to check, these are;

Go to File << Select Options

Select Proofing << tick Check spelling as you type

A spelling mistake usually occurs with a red squiggley line underneath it, as shown below;

To correct the mistake: Right click on the word and the following dialogue box will appear; select the correct spelling.
Review your Document

Thesaurus

The thesaurus enables you to look up synonyms (these are different words with the same meaning), and antonyms are words with the opposite meaning.

Click on the Review tab in the Proofing group << Thesaurus

Example using the thesaurus;

To change the sentence below, I chose the words *a lot* to change to something more appropriate

*Today a lot of great things happened, on this day in 1845 – German composer Felix Mendelssohn's Violin Concerto, one of the most popular and most frequently performed violin concertos of all time, and was first played in Leipzig.*

You can right click on the words and you will get the following box appearing; select a word.

If you select Thesaurus from the dialogue box a list of words appear on the right of your screen.
To insert the word you want to use, click on the down arrow as shown below and choose insert and the new word will be inserted over the word you wanted to change.
Working with Images

Inserting images: From your computer

Use these instructions if you have an image or photo you have saved previously and want to use it in your document.

1. Place your cursor where you want to insert an image.

2. Insert << Picture

3. Browse to where your image is saved << select image file << Insert
Working with Images

Inserting images: From the internet

1. Select the image you want to copy, and use the Keyboard shortcut Ctrl + C to copy the image

Or right click on the picture and select Copy

2. Go back to your document << Paste (CTRL + V)

NB. To save the image to your computer select right click on the image << Save Picture As
3. Save the image to your H: Drive << My Pictures folder << Open

4. Name the file << Save
Working with Images

Inserting images: From Clip Art

1. Place your cursor where you want to insert an image >> Insert >> Clip Art

2. The Clip Art search box appears on the right hand side of the screen

3. Enter keywords into Search for; e.g. balloon << Go

4. Select the image you want to use << Insert
Working with Images

Capturing Screen Snapshots

1. To capture the entire screen click anywhere once
2. Press the Print Screen (PrtScn) key << Paste (Ctrl + V) into your document

1. To capture a window (not the entire screen), e.g. an error message or dialogue box
2. Press both the Alt and PrtScn keys << Paste (Ctrl + V) into your document

NB: The PrtScn key can be in different places depending on the type of keyboard, usually it is located above the Insert key.
Working with Images

Formatting your images

When you have selected an image a new tab appears on the ribbon, Format.

Right clicking on the image will give you a quick list of formatting options as well.

NB: If you only require a portion of the image you have copied use the cropping tool to crop out the parts you don’t need.
WHAT IS A TABLE

A table is information arranged in horizontal rows and vertical columns. You can use a table to organise text or numerical data. You can format text in various ways in different parts of a table.

When you first insert a table into a document, it appears as a simple grid, with black gridlines defining the rows and columns. The area where a row and column meet is called a cell.
Inserting a Table

Insert << Table

Position the mouse pointer in the upper-left cell of the grid, then drag the pointer down and across the grid until you have highlighted the amount you require. For this exercise we will two columns and five rows – the outline of a cell turns orange when you highlight it. NB: You are able to add or delete rows and columns at a later stage if needed.
When you have the table size correct - 2 x 5, an empty table, two columns by five rows, appears, with the insertion point in the upper-left cell.

Example

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you are working in the table or the table is selected two new tabs appear on the ribbon, Design and Layout.
Entering Data in a Table

You can enter data in a table by moving the insertion point to a cell and typing. If the data takes up more than one line in the cell the text will automatically wrap to the next line. This increases the height of that cell and all the other cells in that row. To move to the next insertion point, you can press the Tab key on the keyboard or simply click on the desired cell.

Example

<table>
<thead>
<tr>
<th>Item</th>
<th>Materials Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather stripping</td>
<td>$350</td>
</tr>
<tr>
<td>High efficiency water heaters</td>
<td>$8,500</td>
</tr>
<tr>
<td>High efficiency furnaces</td>
<td>$10,000</td>
</tr>
<tr>
<td>Insulation</td>
<td>$700</td>
</tr>
</tbody>
</table>

This is what selected text looks like, to select the whole table use the Table move handle.

To select a row or column:

Move the mouse pointer to the left of the table next to the row or column. The pointer changes to a right-facing arrow for a row, or a downward facing arrow for a column. Click the left mouse button. The entire row or column is selected.

Example: entire header row selected.
To format the text you can switch to the:

1. **Home tab**

![Home tab](image-url)

2. **Use the Mini toolbar**

![Mini toolbar](image-url)

3. **Or use keyboard shortcuts. (See Keyboard shortcuts)**

![Keyboard shortcuts](image-url)
Sorting Information in a Table

The term sort refers to the process of rearranging information in alphabetical, numerical or chronological order.

Select the whole table

1. Layout << Sort

By default, the table will be sorted by item, the type will be text, and it will be in ascending order.

Example: Unsorted Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Materials Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather stripping</td>
<td>$350</td>
</tr>
<tr>
<td>High efficiency water heaters</td>
<td>$8,500</td>
</tr>
<tr>
<td>High efficiency furnaces</td>
<td>$10,000</td>
</tr>
<tr>
<td>Insulation</td>
<td>$700</td>
</tr>
</tbody>
</table>
Example: Sorted Data on ITEM content << Ascending

<table>
<thead>
<tr>
<th>Item</th>
<th>Materials Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>High efficiency furnaces</td>
<td>$10,000</td>
</tr>
<tr>
<td>High efficiency water heaters</td>
<td>$8,500</td>
</tr>
<tr>
<td>Insulation</td>
<td>$700</td>
</tr>
<tr>
<td>Weather stripping</td>
<td>$350</td>
</tr>
</tbody>
</table>

Example: Sorted Data on MATERIAL COST content << Descending

<table>
<thead>
<tr>
<th>Item</th>
<th>Materials Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>High efficiency furnaces</td>
<td>$10,000</td>
</tr>
<tr>
<td>High efficiency water heaters</td>
<td>$8,500</td>
</tr>
<tr>
<td>Insulation</td>
<td>$700</td>
</tr>
<tr>
<td>Weather stripping</td>
<td>$350</td>
</tr>
</tbody>
</table>
Inserting Rows and Columns in a Table

You will often need to modify a table by adding or deleting rows and columns.

Inserting a column:

Click any cell in the Item column

Layout << Select << Select Column

Rows and Columns Group << Insert Right

A new, blank column is inserted to the right of the item column as shown below:

<table>
<thead>
<tr>
<th>Item</th>
<th>Materials Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather stripping</td>
<td>$350</td>
</tr>
<tr>
<td>High efficiency water heaters</td>
<td>$8,500</td>
</tr>
<tr>
<td>High efficiency furnaces</td>
<td>$10,000</td>
</tr>
<tr>
<td>Insulation</td>
<td>$700</td>
</tr>
</tbody>
</table>

Click in the top cell of the new column, and enter your new data. Use the arrow key to move the insertion point down through the column.

<table>
<thead>
<tr>
<th>Item</th>
<th>Labour Cost</th>
<th>Materials Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather stripping</td>
<td>$3,000 to $4,500</td>
<td>$350</td>
</tr>
<tr>
<td>High efficiency water heaters</td>
<td>$2,000 to $3,000</td>
<td>$8,500</td>
</tr>
<tr>
<td>High efficiency furnaces</td>
<td>$1,000</td>
<td>$10,000</td>
</tr>
<tr>
<td>Insulation</td>
<td>$1,500</td>
<td>$700</td>
</tr>
</tbody>
</table>
Inserting a row:

This is similar to inserting a column.

Select a row below the location where you want to insert a row.

In the Rows and Columns group << Insert Rows Above

To insert a row below select the Insert Below icon. Keyboard shortcut: click at the end of a row in the table where you want a row inserted and press enter.
Deleting rows and columns in a Table

Before you delete a row, you need to work out whether you want to delete the contents of the row, or the contents and the structure of the row. You can delete the contents of the row by selecting the row and pressing the Delete key.

Select the row you are going to delete.

Layout << Delete << Delete Rows

Select the column you are going to delete.

Layout << Delete << Delete Columns
Formating your Table with Styles

Click in the table you want to format.

![Table example](image)

Click Table Tools << Design

In the Table Styles Group, select the downward facing arrow highlighted below to display the Table Styles gallery. In the gallery click on the style you want to use for your table.

![Table Styles gallery](image)

Position your mouse over a style to see a live preview of the style in your document.

![Live preview](image)
Creating a Table of Contents

The easiest way to create a table of contents is to use the built in heading styles for your headings throughout your document.

1. References Tab << Table of Contents

2. Click the arrow in the right hand bottom corner of the Table of Contents, as shown below. This will give you a list of Built-in Automatic Tables.
3. Once you have made your selection you can Insert Table of Contents. When you select Insert Table of Contents the following dialog box will appear;

4. You can make formatting changes to your Table of Contents at this point.

5. You can also increase or decrease the levels of the headings, as shown below.
Updating a Table of Contents

1. If you make changes to your document that change the Page Numbers or Headings you will need to update your Table of Contents.
2. Select the Table of Contents and at the top you will get an Update Table menu. Select Update Table and the changes will be made.
Saving @ EIT

Saving your Document

It is good practice to save your document before you start working on it, and to save it periodically as you continue to add to it, to minimise work lost if something goes wrong. Where you save your document depends on where you are working on it.

Personal Computer at home: “My Documents” on the C: Drive
EIT: H: Drive (never save to the desktop as this is resets every time the computer is re-started)
Home & EIT: USB Memory Stick

NB: As a precautionary measure it is also good practice to also email your document to yourself so there is always a retrievable copy if there are problems with the other copies.

Saving a New Document to your H: Drive

The first time you save a new document at EIT you need to select where save it. This will always happen when you are working on new documents.

Click on Save >> The C: Drive is the default drive to SAVE to at EIT >> Please DO NOT SAVE HERE!

You could lose all of your hard work, because the C: Drive at EIT is for TEMPORARY STORAGE ONLY.
You need to change this to your H: Drive.

Before you save your work, create a New Folder to keep your H: Drive tidy.

Click on the New Folder icon and following will appear in your H: Drive;

Give your New Folder a relevant name e.g. ITHD6.240, see below;

Press Enter >> Click on Open

Create a name for your file
Click Save.

NB: If you are at home or are using a USB to save a new document, make sure it is saving to the right location as mentioned above.

Opening and saving an edited document

Browse to the location of your document and open your document. It will open up in Word automatically. Once you have finished making your changes to your document click on the save icon at the top.

If the save icon is not showing on the top of your document, you need to add it to the Quick Access Toolbar.

To add a button to the Quick Access Toolbar, you need to open the toolbar by clicking on the down arrow, shown below.

Select Save and the Save icon will be added to your Toolbar. This will update your document and save where you opened your document from.
Saving to a USB Memory Stick:

These little devices are great for creating a backup of your work, which you should have just in case something goes wrong and you lose your work on the computer.

As we have already saved our document using the saving techniques above, we are now going to use the Save As facility on the keyboard.

Make sure your USB is plugged into a USB port at the front of the computer.

With your document still open >>Press the F12 key on the keyboard and the following screen will appear;

This time we need to select the USB (E: drive), as shown below;
It should be empty the first time you use it

![Image of Save As window]

Click on Save;

![Image of Save dialog box]

Your document should be saved to your USB.

Once you have finished copying over your documents you will need to safely remove it so that work copied to it will not be lost.

Close all open documents that you have been working on.

Click on the device with a tick symbol at the bottom right of your screen,

Click on Eject USB (the name of your USB)

![Image of Eject device]

A message will show telling you, you can safely remove your USB. Remove the USB from the front of the computer.